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STRUCTURE OF EVALUATION MATIRIALS 
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3. Review of WCF 

4. Passport of valuation means 

5. A set of evaluation tools 

 Standards of test tasks (with title page and table of contents) 

 Examination 
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The passport of the evaulation matirial 

discipline Medical informatics 

№ 

п/п 

The name of the controlled section (topic) of 

the discipline / module 

Codes of 

competence 

Name of 

valuation means 

1 2 3 5 
1 Information concept. 

General characteristics of the processes of 

collection, transmission, processing and 

accumulation of information. Methods and means 

of informatization in medicine and health care 

GPC-10 

UC-1 

Test,  

2 Telecommunication technologies and Internet 

resources in medicine. 
GPC-10 Test,  

3 Basic information conversion technologies. GPC-10 

 

Test,  

4 Modeling of physiological, morphological, 

molecular-genetic and biochemical processes. 
GPC-10 

 

Test,  

5 Optimization of treatment. The use of information 

computer systems in medicine and healthcare. 

Information systems of medical institutions 

GPC-10 

UC-1 

Test,  
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Questions for the exam 

in the discipline "Informatics, medical informatics and statistics" 

for 1st year students of the Faculty of General Medicine 

 

1. Scanner and its types. Main characteristics of the monitor. Types of printers. Main parameters. 

2. Archiver WinRar and its capabilities. WinAce archiver and its functions. Archives, archivers. 

WinZip archiver and its capabilities. Create an archive using WinZip. Unpacking the archive. 

3. Formats of archivers. Video, sound and music formats. Executable and graphic formats. 

4. Computer networks. KS types. 

5. Email account. Registration name. E-mail address. Email message, email folders. Email. Email 

protocols. Mail server. Mail client. 

6. Registration of an electronic mailbox in the Internet postal services. Required fields for 

registering an email address. Attached file. Methods for sending email messages (simple 

message, extended message, postcard, attached file). 

7. The concept of "informatics", "information", properties of information. The concept of 

"information technology". Data, method and program. Basic data structures. 

8. The main characteristics of the hard disk. Optical discs. Standard keyboard. Modem. 

9. TV tuner. Sound card. Network Card. Webcam. Acoustic system. Chipset. South and North 

Bridge. Main tires. 

10. The concept of an archive, archiver. Self-extracting archive, multivolume archive. Console 

archivers. 

11. Basic PC configuration. Internal devices of the PC. Peripherals Motherboard. RAM. ROM. 

CPU. Its main parameters. 

12. Number systems. Types of SS. Positional SS. Non-positional SS. Encoding and decoding. 

The process of encoding numerical information. 

13. Software. Browser, its functions, types of browsers and methods of launching the program. 

14. Interface elements of the Internet Explorer window Functions of Internet Explorer navigation 

buttons. 

15. Computer virus. Properties and manifestations of the virus. Classification of computer 

viruses. Antiviruses. Types of antivirus programs. Basic requirements for antivirus programs. 

16. Method of table-wave (Wave-Table) synthesis. The process of encoding graphic information. 

The process of encoding text information. FM (Frequency Modulation) method. 

17. Prevention and treatment of computer viruses. Several rules for preventing infection. 

18. Operations with data. Data units. File. File name. File structure. 

19. Antiviruses. Types of antivirus programs. Basic requirements for antivirus programs. 

20. Basic commands of the text menu. Browser context menu. Internet Options dialog box. Fine 

tuning the browser. 

21. Methods of search in the Yandex system (search by one word, group of words, quotation, 

name, excluding words from the search, search results, sorting results, similar documents, 

parallel searches, search in the found). Google search techniques (traditional search, catalog 

search, newsgroups, images). Search engine Yandex. Google search engine. 
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22. Search index. Three stages of processing a request with a search index. Four types of 

information retrieval. 

23. 4 basic principles of building MIS. Give and describe your understanding of the common 

information space created within the healthcare facility through the use of MIS. 

24. List the most important requirements for IIAs. Describe the difference between using separate 

programs for healthcare facilities and a unified information system. Describe and comment on 

a typical scheme of information circulation around the doctor. 

25. Describe the purpose, features and role of electronic medical history (EIB) and electronic 

ambulatory card (EAC) in MIS. The difference between EIB and EAK from their paper 

counterparts. 

26. The ability of MIS to reduce routine operations in the course of a doctor's work. Give 

examples. Explain the principle of collaboration used in modern IIAs. 

27. "Security" in the context of medical information systems. List and describe the main areas of 

information systems security. List the locations of potential threats to the MIS security, list 

and describe the existing types of threats and protections. Describe the organizational, 

administrative and software and hardware measures to protect information in the MIS. 

28. List the main typical elements of the MIS security subsystem. Describe the purpose of 

elements such as user identification and authentication. Indicate what is the essence of the use 

of crypto-protection, registration of events in the MIS, support of third-party means of 

protection and protection from alien programs while ensuring the security of the MIS. 

29. Explain the main features of the use of electronic document management (ED) in a medical 

institution. Advantages and disadvantages of introducing ED in health care facilities. 

Electronic digital signature (EDS), its application in MIS and its capabilities. 

30. Describe the possibilities and justify the need to use user groups when organizing the 

differentiation of access rights for MIS users. What is the essence of the three-dimensional 

system of distribution of rights in IIAs. The impact of restricting access to information on the 

work of users with MIS. 

31. Organizational stress Representation of data and knowledge in GIS (two approaches) 

32. Information processes. List and describe operations on data. 

33. Types of information depending on their classification. List and describe the properties of the 

information 

34. Communication. The relationship of message and information. Describe and explain the 

message transfer scheme 

35. Information. Scientists' opinion about information. 

36. Mathematical statistics. Two sections of medical statistics. 

37. What is GIS-DKOS based on 

38. Data generation models. 

39. Medical informatics, subject, object of MI. Basic methods of research of MI. MI tasks 

40. The subject of the theory of probability. What data generation models do you know, describe 

each of them. 

41. Initial treatment in the framework of medical statistics. Re-appeal within the framework of 

medical statistics. 

42. Primary morbidity. General morbidity. 

43. Noise, information noise. 
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44. Morbidity with hospitalization. Incidence with temporary disability. 

45. Patterns in data and knowledge. List the patterns. 

46. Building databases and knowledge. 

47. Interface elements of the word processor window. Rules for typing text information. 

Automatic hyphenation. 

48. Editing text. Working in Microsoft Word using hotkeys. Font and paragraph formatting. 

Setting borders around text. 

49. Tabulation of text information. Creation of lined forms. Tabulation in table cells. 

50. Creating the structure of tables, formatting tables. Creating and using nested tables. Special 

cases when working with tables in the text. General requirements for the design of tabular 

information. 

51. Interface elements of the Excel window. Filling and formatting cells. Copying cells and data 

in cells. Hide and show rows and columns. 

52. Working with blocks of information. Control of data entry into the cell. Search and 

replacement of information. Sorting, ordering and filtering records. 

53. Concept of function. Basic Excel functions. Working with the Function Wizard. Range Finder 

Using Built-In Aggregates .. 

54. The concept of a list, database and list item. Summarizing the filtered list. Obtaining summary 

cumulative statements. 

55. Interface elements of the PowerPoint window. Using templates to create presentations. Types 

of presentations and stages of creating a presentation. 

56. Creating a presentation using PowerPoint. Insert various objects into the presentation. 

Formatting presentations. 

57. Computer networks. Types of networks. World wide web concept. 

58. Internet addressing. Domain name system. 

59. Data transmission protocols TCP / IP. 

60. Browser interface and its customization. 

61. E-mail. Email protocols. 

62. Search engines. Types of search in the global network. Medical Internet resources. 

63. Modeling physiological processes using Access. 

64. Basic concepts and definitions. Program window interface. 

65. Creating a database and ways to create tables in Access. Populating a table in the database. 

66. Key field and its types. 

67. Relational databases. Types of links in Access. Create relationships between tables in Access. 

68. Creating a form using the Form Wizard. Creating a form using the Constructor. 

69. Creation of queries and reports in the database.  
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FEDERAL STATE BUDGETARY EDUCATIONAL INSTITUTION OF HIGHER 

EDUCATION "NORTH OSSETIAN STATE MEDICAL ACADEMY" OF THE 

MINISTRY OF HEALTH OF THE RUSSIAN FEDERATION 

REVIEW 

FOR EVALUATION MATERIALS 

 

in the discipline "Medical informatics" 

for 1st year students 

in the specialty 31.05.01 Medical care 

The evaluation materials were compiled at the Department of Chemistry and Physics on 

the basis of the work program of the discipline "Medical Informatics" and comply with the 

requirements of the Federal State Educational Standard in 3++  

The evaluation materials was approved at a meeting of the Central Coordination 

Educational and Methodological Council and sealed with the seal of the educational and 

methodological management. The evaluation materials  means includes a bank of test items and 

questions for the final test for the discipline. 

The bank of test items includes test items and response templates. All tasks correspond to 

the work program of the discipline Medical Informatics and cover all its sections. The number of 

test items ranges from 20 to 39. 

There are no comments to the peer-reviewed the evaluation materials. 

In general, the evaluation materials  for the discipline "Medical Informatics" contributes 

to a qualitative assessment of the level of students' mastery of universal and professional 

competencies. 

The peer-reviewed the evaluation materials for the discipline "medical informatics" can 

be recommended for use for intermediate certification for students of 1 year of study in the 

specialty 31.05.01 General medicine.. 

 

 

 

 

 

 

 

 

 

Chairman of the TsUMC of natural sciences 

And mathematical disciplines with the subcommittee 

On examination of evaluation tools. Associate Professor  N I Botsieva 
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View 
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The concept of information. 

General characteristics of the processes of data collection, transmission, processing and 

accumulation. Methods and means of informatization in medicine and public health. 

 

TOPIC: Basics of Computer Literacy 

 

1. What is information? 

 

All useful data; 

The result of the interaction of data with the user; 

The product of user interaction with adequate methods 

  

 

2. Give the definition of "completeness of information" 

 

This is the degree to which information corresponds to the current time 

Measure of the possibility of obtaining this or that information 

Degree of conformity to the real, objective state of affairs 

 This is the quality of information and the adequacy of the data for decision making 

This corresponds to the levels of useful and foreign signals. 

 

3. Give the definition of "Reliability of information" 

 

This is the degree to which information corresponds to the current time 

Measure of the possibility of obtaining this or that information 

This is the quality of information and the adequacy of the data for decision-making 

Degree of conformity to the real, objective state of affairs 

 This corresponds to the levels of the useful and foreign signals. 

 

4. Give the definition of "Adequacy of information" 

 

This corresponds to the levels of useful and foreign signals. 

This is the quality of information and the adequacy of the data for decision-making 

This is the degree to which information corresponds to the current time 

Measure of the possibility of obtaining this or that information 

 Degree of conformity to the real, objective state of affairs 

 

5. Define the notion of "Accessibility of information" 

 

This corresponds to the levels of useful and foreign signals. 

This is the quality of information and the adequacy of the data for decision-making 

This is the degree to which information corresponds to the current time 

 Measure of the possibility to obtain this or that information 

This is the degree of correspondence to the real, objective state of affairs 

 

6. Give the definition of the concept of "relevance of information" 

 

 This is the degree to which information corresponds to the current time 

This is the quality of information and the adequacy of the data for decision-making 

This corresponds to the levels of useful and foreign signals. 

Measure of the possibility of obtaining this or that information 

This is the degree of correspondence to the real, objective state of affairs 
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7. What is binary encoding? 

 

 Data expression with the sequence 0 and 1; 

Expression of data with the sequence 0, 1 and 2; 

Expression of data by sequence 0 and 2; 

There is no correct answer. 

 

8. Define the operation "Data collection" 

 

This is the ordering of data by a given characteristic for the sake of convenience 

This is the transfer of data from one form to another or from one structure to another 

This is the organization of data storage 

This is the screening of "extra" data, in which there is no need for a decision 

This is the reduction of data coming from different sources, to the same form, to make 

them comparable to each other 

 This is the accumulation of information to ensure sufficient completeness for decision-

making 

This is a set of measures aimed at preventing loss, reproduction and modification of data 

This is the reception and transmission of data between remote 

9. Define the operation "Data formalization" 

 

This is the ordering of data by a given characteristic for the sake of convenience 

This is the transfer of data from one form to another or from one structure to another 

This is the organization of data storage 

This is the screening of "extra" data, in which there is no need for a decision 

 This is bringing the data coming from different sources to the same form to make them 

comparable to each other 

This is the accumulation of information in order to ensure sufficient completeness for 

decision-making 

This is a set of measures aimed at preventing loss, reproduction and modification of data 

This is the reception and transmission of data between remote 

 

10. Define the operation "Data Filtering" 

 

This is the ordering of data by a given characteristic for the sake of convenience 

This is the transfer of data from one form to another or from one structure to another 

This is the organization of data storage 

 This is the screening out of "superfluous" data, in which there is no need to make a 

decision 

This is the reduction of data coming from different sources, to the same form, to make 

them comparable to each other 

This is the accumulation of information in order to ensure sufficient completeness for 

decision-making 

This is a set of measures aimed at preventing loss, reproduction and modification of data 

This is the reception and transmission of data between remote 

 

11. Define the operation "Sorting data" 

 

 his is the ordering of data according to a given characteristic for the convenience of use 

This is the transfer of data from one form to another or from one structure to another 

This is the organization of data storage 

This is the screening of "extra" data, in which there is no need for a decision 
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This is the reduction of data coming from different sources, to the same form, to make 

them comparable to each other 

This is the accumulation of information in order to ensure sufficient completeness for 

decision-making 

This is a set of measures aimed at preventing loss, reproduction and modification of data 

This is the reception and transmission of data between remote 

 

12. Define the operation "Data archiving" 

 

This is the ordering of data by a given characteristic for the sake of convenience 

This is the transfer of data from one form to another or from one structure to another 

 This is the storage organization 

This is the screening of "extra" data, in which there is no need for a decision 

This is the reduction of data coming from different sources, to the same form, to make 

them comparable to each other 

This is the accumulation of information in order to ensure sufficient completeness for 

decision-making 

This is a set of measures aimed at preventing loss, reproduction and modification of data 

This is the reception and transmission of data between remote 

 

13. Define the operation "Data protection" 

 

This is the ordering of data by a given characteristic for the sake of convenience 

This is the transfer of data from one form to another or from one structure to another 

This is the organization of data storage 

This is the screening of "extra" data, in which there is no need for a decision 

This is the reduction of data coming from different sources, to the same form, to make 

them comparable to each other 

This is the accumulation of information in order to ensure sufficient completeness for 

decision-making 

 This is a set of measures aimed at preventing loss, reproduction and modification of data 

This is the reception and transmission of data between remote 

14. Define the operation "Transportation of data" 

 

This is the ordering of data by a given characteristic for the sake of convenience 

This is the transfer of data from one form to another or from one structure to another 

This is the organization of data storage 

This is the screening of "extra" data, in which there is no need for a decision 

This is the reduction of data coming from different sources, to the same form, to make 

them comparable to each other 

This is the accumulation of information in order to ensure sufficient completeness for 

decision-making 

This is a set of measures aimed at preventing loss, reproduction and modification of data 

 This is the reception and transfer of data between remote computers 

 

15. Define the operation "Data conversion" 

 

This is the ordering of data by a given characteristic for the sake of convenience 

 This is the transfer of data from one form to another or from one structure to another 

This is the organization of data storage 

This is the screening of "extra" data, in which there is no need for a decision 
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This is the reduction of data coming from different sources, to the same form, to make 

them comparable to each other 

This is the accumulation of information in order to ensure sufficient completeness for 

decision-making 

This is a set of measures aimed at preventing loss, reproduction and modification of data 

This is the reception and transmission of data between remote 

 

16. List the main data storage structures 

 

Sequential 

 Hierarchical 

 Linear 

Address structure 

Tabular 

 

17. How many parameters determine address data in a linear structure? 

 

 One 

Two 

Three 

There is no correct answer 

 

18. What is a file structure? 

 

 The principle of storing data as files on a disk 

The principle of recording data as a file on disk 

The principle of organizing the placement of data in the form of files on the disk 

 

19. What is the characteristic of the monitor? ******* - This is the parameter that determines 

how often the image on the screen is redrawn again. 

 

Resolution monitor 

Monitor protection class 

 Monitor regeneration frequency 

Display resolution 

 

20. Which key group is used only in combination with other keys? 

 

ENTER, DELETE, ALT 

 ALT, SHIFT, CTRL 

SHIFT, CAPS LOCK, TAB 

CTRL, BAKSPACE, ENTER 

 

21. In what chip are the data stored after the computer is turned off? 

 

Random Access Memory 

 Read Only Memory 

HDD 

Flexible drive 

CD 
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22. How much will the image have at the resolution of 100x200 pixels under the condition of 32-

bit encoding? 

 

800 Byte 

 80,000 Bytes 

6,400 bytes 

644,000 Bytes 

 

23. Note the main parameters of laser printers: 

 

Capacity 

 Productivity 

 The amount of native RAM 

Bit depth 

 Resolution 

 The paper size used 

Quality of the resulting image 

 

24. The following applies to Windows management objects: 

 

 The taskbar 

Files 

Mouse 

Pixels 

 

25. To select an object on the Windows desktop, use: 

 

F8 key on the keyboard 

Num Lock 

Double-click 

 Click the left mouse button 

 

26. The main icons on the Desktop are: 

 

 My Computer 

Local disk (C) 

 Network Neighborhood 

Latest documents 

 Internet Explorer 

Control Panel 

 My Documents 

My drawings 

 Cart 

 

27. The folder window contains the following elements: 

 

 Title bar 

Control Panel 

 Size control buttons  

 Menu Bar 

Context menu 

 Toolbar 
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 Address bar 

 Workspace 

Task bar 

 Scroll bars 

 Status bar 

 

28. The conductor is ...: 

 

 Utiliy program 

File structure 

Disk Checker 

Programming language 

 

29. Choose four types of object representation in the Windows folder window: 

 

 Large icons 

By name 

 Small icons 

To size 

 List 

By date 

 Table 

 

30. Select the items that belong to the structure of the main menu: 

 

 Programs 

My Favorites 

Menu Bar 

Toolbar 

Workspace 

 Setting 

 Find 

 Execute 

 Shutdown 

Task bar 

Scroll bars 

Status bar 

Ending a Session 

Title Bar 

Control Panel 

 

31. What is the data? 

 

Different signals 

Useful signals 

 Registered Signal 

Helpful information 

 

32. The frequency modulation method used to encode audio information is: 

 

A continuous process that changes continuously in time 

Intermittent process, proceeding not constantly, but intermittently 
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 
different frequencies 

There is no correct answer 

 

33. What is included in the full file name? 

 

The name of the root directory 

  

 File access path 

File extension 

File contents 

 

34. What is included in the basic hardware configuration? 

 

 The system unit 

 Mouse 

 Keyboard 

Modem 

Printer 

 

35. What varieties are divided into the cases of the system unit? 

 

 Flat 

Narrow 

Thin 

 Extremely flat 

Particularly narrow 

Particularly thin 

 

36. What unit is used when it comes to monitor resolution? 

 

Letters 

The figure 

 Point 

Cell 

Bit 

 

37. Arrange the following devices in order of increasing resolution: 

2 

Drum Scanner 

1 

Handheld scanner 

3 

Flatbed scanner 

 

38. What is the purpose of the "address bus" 

 

It is intended for copying data from the main memory to the registers of the processor and 

back 

 It is intended for copying data about the location of the memory cells 

It is designed to enter the processor commands 
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39. What is the purpose of the "Data Bus" 

 

It is intended for copying data from the main memory to the registers of the processor and 

back 

It is intended for copying data about the location of the memory cells 

 Intended to enter the processor commands 

 

40. What is the purpose of the "control bus" 

 

 Used to copy data from the main memory to the processor registers and back 

It is intended for copying data about the location of the memory cells 

It is designed to enter the processor commands 

 

41. A device for exchanging information between remote computers via communication 

channels is: 

 

Printer 

Scanner 

 Modem 

Keyboard 

Digital camera 

 

42. The Windows management tools are: 

 

 Mouse 

  Keyboard 

Task bar 

Joystick 

 

43. A label is: 

 

Part of the file 

Name of the program or document 

 Link to a program, document or folder 

Folder 

 

44. The My Computer icon serves for: 

 

Exit to the Internet 

Access to all computer resources 

 Access to user documents 

Shutdown the computer 

 

45. The context menu is invoked: 

 

 Right-click 

Click the left mouse button 

Double-click the left mouse button 

Double-click the right mouse button 

 

46. The clipboard is: 
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 An invisible area of memory that is used to exchange information between programs 

Context menu 

Utility program 

Permanent memory 

 

46. What is a storage medium? 

 

A device that stores data for a certain period of time 

 Device for moving data 

Data presentation form 

 

47. To encode the text data in the Russian-language coding system, it is enough: 

 

2 bits 

16 bits 

 8 binary digits 

 

48. The universal system for encoding text data provides codes: 

 

For 256 different characters 

 For 65536 different characters 

For 36636 different characters 

There is no correct answer 

 

49. Define the concept of "User Interface" 

 

 These are methods and means of human interaction with hardware and software 

This interaction of hardware parts between each other 

This is the interaction of program parts with each other 

This interaction of hardware and software parts 

 

50. Give the definition of "Hardware Interface" 

 

These are methods and means of human interaction with hardware and software 

 This is the interaction of the hardware parts with each other 

This is the interaction of program parts with each other 

This interaction of hardware and software parts 

 

51. Give the definition of "Hardware-software interface" 

 

These are methods and means of human interaction with hardware and software 

This interaction of hardware parts between each other 

This is the interaction of program parts with each other 

 This is the interaction of hardware and software parts 

 

52. Give the definition of the term "program interface" 

 

These are methods and means of human interaction with hardware and software 

This interaction of hardware parts between each other 

 This is the interaction of the program parts with each other 

This interaction of hardware and software parts 
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53. What is the interface? 

 

The environment through which processes are efficient 

The environment through which the data is converted 

 The environment through which various operations are automatized 

There is no correct answer 

 

54. Which key performs non-fixed switching between the upper and lower registers when 

entering text information? 

 

CAPS LOCK 

DELETE 

 SHIFT 

ALT 

 

55. Select the devices located on the motherboard: 

 

Flexible drive 

 Processor 

  Chipset 

HDD 

 RAM 

 ROM 

Hard disk controller 

 Tires 

 

56. What is the purpose of the video card? 

 

To view digital photos 

To view black and white video clips 

 To enable the display of information on the monitor screen 

To view color video clips 

 

57. The main characteristic of a sound card is: 

 

Volume 

Resolution 

 Bit depth 

Acceleration 

 

58. Windows is: 

 

 Operating system 

Supporting program 

Utility program 

Program for working with graphic files 

 

59. The Start button is used to: 

 

 Access to the main commands grouped as menus 

To turn on the computer 

To connect a computer to the Internet and disconnect from it 
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Shutdown the computer 

 

60. The icon "Network Neighborhood" serves for: 

 

Exit to the Internet 

Access to computer devices 

Access to user documents 

 Access to local network resources 

 

61. The folder into which the objects to be deleted are temporarily placed: 

 

Catalog 

File 

Label 

 Cart 

 

62. List the main properties of information from the point of view of informatics 

 

 Reliability 

Versatility 

Multipolarity 

 Objectivity 

 Completeness 

 Adequacy 

Confidentiality 

 Availability 

 Reliability 

 

63. List the data units in ascending order: 

2 

Byte 

3 

Kbytes 

6th 

TB 

5 

GBytes 

4 

MB 

1 

Bit 

 

64. When encoding graphic data, it is envisaged to use: 

 

 The linear coordinates of each screen point 

Set of smallest points 

 Individual properties of each point 

A pattern called a raster 

Polygraphy 

Palettes 

 

65. What is a file? 
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An arbitrary number of bits sequence 

A sequence of a fixed number of bits that have their own name 

 Sequence of an arbitrary number of bytes that have their own name 

There is no correct answer 

 

66. What interface does the keyboard and monitor combination provide? 

 

Software interface 

 User interface 

Hardware-software interface 

 

67. What is a catalog? 

 

Group of files on disk 

The main file on the disk 

 Logical merging of files and folders on the disk 

 

68. Which type of device will you use to monitor? 

 

Input device 

 Output device 

Storage device 

 

69. What kind of device does the mouse device belong to? 

 

Output Device 

Data Conversion Device 

 Manipulator type 

A device for exchanging data between remote sources 

 

70. Note the two main parameters of the hard disk: 

 

Bit depth 

 Capacity 

Resolution 

 Productivity 

Volume of native RAM 

 

71. Where is the set of programs stored, the main purpose of which is to check the composition 

and operability of the computer system and provide interaction with the keyboard, monitor, hard 

disk and floppy drive? 

 

in RAM 

 in the ROM 

on the hard disk 

in the Cache memory 

 

72. How many can be cylindrical rods (needles) for matrix printers? 

 

 9 

10 
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12 

15 

21 

 24 

25 

 

73. The Windows desktop is called: 

 

Windows Window 

 This is a Windows graphical environment 

Windows Panel 

Windows Wallpapers 

 

74. The taskbar is used for: 

 

Access to network resources 

Access to computer devices 

 Mapping and switching between the current tasks 

Access to network resources 

 

 

75. The icon "Internet Explorer" serves for: 

 

 Access to the Internet 

Access to computer devices 

Access to user documents 

Shutdown the computer 

 

76. The button located in the title bar of the Windows window means: 

 

«Collapse» 

 "deploy-restore" 

«Switch to another window» 

The button located in the title bar of the Windows window means: 

 

77. The database is 

 

Information represented by a set of tables; 

 It is an objective form of representation and organization of a set of data systematized in 

such a way that these data are found and systematized with the help of a computer; 

The set of MS EXCEL tables; 

There is no correct answer 

 

78. List the operations with data 

 

 Sorting data 

 Filtering 

 Archiving 

 Transportation 

 Protection 

 Transformation 

 Formalization 
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 Data collection 

Availability 

Relevance 

Hybridity 

Reliability 

 

79. List the methods of encoding audio information 

 

 FM method 

Radio method 

 Wave-Table method 

Sample method 

 

Telecommunication technologies and Internet resources in medicine. 

 

1. What are the programs that allow you to view Web pages? 

Adapters 

OS 

 Browsers 

Translators 

 

2.What is HTTP? 

A network that combines electronic bulletin boards 

 Hyper Text Transfer Protocol 

A group of messages about a particular topic 

A computer connected to a network 

 

3. What do I need to publish a website? 

 URL 

mail address of the user 

email address of the user 

username and password 

 

4.What can be used as an object when creating a hyperlink? 

provider firm 

network protocol 

 picture 

tag 

 

5. If you are not sure when writing the word BEAR when searching for information, what search 

option is appropriate for this case? 

 M * DOUBLE 

M THE DOBLE 

M # DED 

M? DED 

 

6. A computer connected to the Internet must have ... 

 IP address 

WEB-server 

Domain name 

Home Web Page 
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7. Modem is ... 

mail program 

network protocol 

Internet Server 

 technical device 

 

8. In the text editor, the operation Copy is made possible after: 

setting the cursor to a specific position 

saving file 

print file 

 highlighting a piece of text 

 

9.What is a chip? 

electric lamp 

 integrated circuit 

information backbone 

processor type 

 

10.Polyfagi is ... 

 Antivirus software 

viruses 

browser 

search system 

 

11The e-mail address in the Internet is set: user_name@mtu-net.ru. What part of the address 

points to the top-level domain? 

 ru 

mtu-net.ru 

user_name 

mtu-net 

 

12. Searching for information on the Internet for keywords suggests 

 Enter a word (phrase) in the search bar 

entering a word (phrase) in the address bar 

go through hyperlinks from the first page loaded 

 

13.EBS is ... 

electronic form 

 electronic library system 

electronic medical history 

 

14. Relationships between descriptors can be: 

 hierarchical 

associative 

linear 

network 

 

15. At the top level of the thesaurus hierarchy are: 

8 descriptors 

10 descriptors 

12 descriptors 

 16 descriptors 
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16. The MeSH thesaurus is ... 

 Thesaurus of the National Medical Library of the United States 

thesaurus of the medical library of Russia 

Thesaurus of the Medical Library of England 

thesaurus of the International Medical Library 

 

17.Head of medicines -... 

Lib-Med 

 VIDAL 

"Encyclopedia of medicines - RLS" 

 

18. For narrowing topics in the thesaurus include: 

 Set of qualifiers 

Set of descriptors 

All of the above 

 

19. Is the number of the descriptor changing with the development of the thesaurus? 

no 

 yes 

 

20. Descriptors are provided with: 

interpretations 

a list of synonyms or related terms 

 All of the above 

21. A descriptor is ... 

 word, a combination of information retrieval language, which serves to describe the main 

semantic content of the document 

glossary of terms 

dictionary of qualifiers 

 

22. The Thesaurus is ... 

a word, a word-combination of the information retrieval language, serving for the description of 

the main semantic content of the document 

 dictionary of terms 

dictionary of qualifiers 
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Module 

 

1. Hypertext is ... 

 

very large text 

 structured text in which transitions on selected labels can be performed 

text typed on a computer 

text that uses a large font 

 

2. The e-mail address in the Internet is set: user_name@mtu-net.ru. What is the name of the 

owner of this email address? 

 

en 

mtu_net.ru 

 user_name 

mtu-net 

 

3. Browsers are ... 

 

Internet servers 

antivirus software 

programming language translators 

 web browser 

 

4. Internet servers, containing file archives, allow ... 

 

 Download the required files 

to recieve e-mail 

participate in teleconferences 

videoconferencing 

 

5. A computer connected to the Internet must have ... 

 

 IP address 

web server 

home web page 

Domain name 

 

6. The modem is ... 

 

 mail program 

network protocol 

Internet Server 

 technical device 

 

7. To access to which information resource of the Internet in the universal resource index (URL) 

is the HTTP protocol used? 

 

 To the mail box. 

 WEB-page 

 File in the file archive 

 Teleconferences 
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8. Programs that are in accordance with the license agreement can be used for a strictly defined 

time free of charge, are denoted by the term ... 

 

Hardware 

 Shareware 

 Freeware 

 Software 

 

9. In the global computer network, the Internet transport protocol Transport Control Protocol 

(TCP) provides ... 

 

transfer of information to a given address 

 splitting the transferred file into parts (packages) 

receiving email messages 

transmission of e-mail messages 

 

10. The URL of the Web page is set: http://www.mipkro.ru/index.htm What is the name of the 

protocol for accessing this information resource? 

 

www.mipkro.ru 

 http 

index.htm 

en 

 

11. To access the files stored on the file archive servers, the protocol is used ... 

 

HTTP 

 FTP 

POP 

SMTP 

 

12. E-mail (e-mail) allows you to send ... 

 

only messages 

only files 

 messages and attached files 

video image 

 

13. HTML (Hyper Text Markup Language) is ... 

 

the Internet server 

 means of creating web pages 

a programming language translator 

web page viewer 

 

14. The e-mail address in the Internet is set: user_name@mtu-net.ru. What is the name of the 

mail server? 

 

en 

user_name@mtu-net.ru 

user_name 
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 mtu-net.ru 

 

15. Hyperlinks on a web page can provide a transition ... 

 

 on any web page of any Internet server 

to any web page within this domain 

on any web page of this server 

within this web page 

 

16. The e-mail address on the Internet is set: user_name@mtu-net.ru. What is the top-level 

domain name? 

 

 ru 

mtu-net.ru 

user_name 

mtu-net.ru 

 

17. Web pages have the format (extension) ... 

 

TXT 

 HTM 

DOC 

EXE 

 

18. Programs that can be used for free and copied are indicated by a computer term ... 

 

Hardware 

Shareware 

 freeware 

Software 

 

19. For access to which Internet resource in the universal resource index (URL) is the FTP 

protocol used? 

 

mailbox 

 file in the file archive 

Web page 

Teleconferences 

 

20. A protocol is used to access Web pages ... 

 

 http 

FTP 

POP 

SMTP 

 

21. In the global Internet computer network, the Internet Protocol (IP) routing protocol provides 

... 

 

 transfer of information to a given address 

splitting the transferred file into parts (packages) 

receiving email messages 
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transmission of e-mail messages 

 

22. To access the files stored on the file archive servers, the protocol is used ... 

 

POP 

SMTP 

HTTP 

 FTP 

 

23. The local computer network unites computers installed: 

 

in two rooms and buildings; 

 in one room and building; 

In different cities. 

 

24. The World Wide Web is: 

 

PC in the local network; 

PCs in the regional network; 

PC in the corporate network; 

 in all the above 

 

25. The domain name system has: 

 

network structure; 

linear structure; 

 hierarchical structure. 

 

26. Routing and transportation of data on the Internet is carried out on the basis of: 

 

transport protocol; 

routing protocol; 

 TCP / IP protocol. 

 

27. Please choose a valid email address: 

 

ivanpetrov @ mail 

ivan_petrov.mail.ru 

ivan petrov.mail.ru 

 ivan_petrov@mail.ru 

 

28. Which top-level domain means "educational site"? 

 

mil 

gov 

com 

 edu 

 

29. The Protocol is ... 

 

the ability of a computer to send files through information transfer channels 

LAN device 
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 standard for data transmission through a computer network 

standard for sending messages via e-mail 

 

30. The classification of networks "According to territorial prevalence" does not include: 

 

Regional 

Global 

 City 

Local 

 

31. The global network is ... 

 

system of interconnected computers 

a system of interconnected local area networks 

a system of interconnected local telecommunications networks 

 system, interconnected local area networks and individual users' computers 

 

Basic information conversion technologies. 

Primary Word Formatting 

 

1. To create page parameters use the command line menu: 

 

File-Page Options 

Page Layout-Page Options 

 Page Layout-Orientation 

Format-Page Options 

 

2. A Microsoft Word document is a file with the extension: 

 

txt 

ppt 

xls 

 doc 

 

3. To select a line of text with the mouse, click the mouse: 

 

to the left of the text line 

 To the right of the text line 

inside a line of text 

 

4. Move through the document using the keys: 

 

PgUp 

 PgUp Ctrl + Home, Ctrl + End, PgDn 

Ctrl + Home, Ctrl + End 

PgDn, PgUp 

 

5. To design the textual information of the document, use the following: 

 

 the Home tab and in the Paragraph dialog box 

 Home tab and in the Font dialog box 

Home tab and in the Styles dialog box 
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Standard toolbar 

  

6. Microsoft Word is: 

 

graphics editor 

 word processor 

tabular processor 

 

 7. To align the paragraph to the width, use a set of shortcut keys: 

 

 Ctrl + J 

Ctrl + L 

Ctrl + R 

Ctrl + E 

8. The cursor to indicate the current insertion point of the text is called: 

 

 Keyboard 

Text 

Graphic 

 

9. To quickly move the input cursor around the document, use the mouse cursor: 

 

Keyboard 

Graphic 

 text 

 

10. For more accurate adjustment of the sliders of the scale ruler, when dragging, use the key: 

 

 Alt 

Tab 

Shift 

Ctrl 

 

11. The buttons located in the upper right corner of the application window are 

 

 window control buttons 

system menu 

toolbar 

line Menu 

 

12. What does the Ctrl + N key combination mean: 

 

 creating a new document 

opening an existing document 

printout 

saving a document 

 

13. What does the key combination Ctrl + F12 mean: 

 

printout 

saving a document 

document creation 
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 opening an existing document 

 

14. To visually compare the text information on the screen, use: 

 

scroll bars 

status line 

Workspace 

 scale scale 

 

 

15. The font size is measured in: 

 

Millimeters 

pixels 

 Points 

Centimeters 

 

16. To enter text anywhere in the workspace, you need: 

 

do a single click with the right mouse button 

do a single click with the left mouse button at this point and enter text 

 double-click the left mouse button 

 

17. Formatting of characters in Word-e is carried out by the command: 

 

File 

Service 

 Format 

Insert 

 

18. To center the paragraph on the center, use a set of shortcut keys: 

 

Ctrl + R 

 Ctrl + E 

Ctrl + J 

Ctrl + L 

 

19. To set the hyphenation in documents, use the command: 

 

 Page Layout 

Insert 

home 

Format 

 

20. For conducting double horizontal lines it is necessary: 

 

 On the empty line, type "equal" three times and press Enter 

On an empty line type "- - -" and press Enter 

 

21. Scale rulers are used: 

 

 to format paragraphs (specify indent, ledge, left and right borders) 
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 for the possibility of placing text in strictly defined places from the left and right edges of 

the paper 

 to change the page margins 

to set the line spacing 

 

22. Specify the correct keyboard shortcuts: 

 

 Cut text - CTRL + X 

Cut text - CTRL + W 

 Copy text - CTRL + C 

Copy text - CTRL + I 

 Insert text - CTRL + V 

 Save document - CTRL + S 

 Open document - CTRL + O 

 Create new document - CTRL + N 

 

23. To arrange hyphens, you need to call up the menu: 

 

 the Ribbon Page Layout tab, in the Page Setup group, click the Hyphenation button. 

the Insert ribbon tab, in the Page settings group, click the Hyphenation button. 

the Home tab, in the Page Setup group, click the Hyphenation button. 

 

24. The External Boundary tool, for drawing lines from the top and bottom of the paragraph, is 

located on the toolbar: 

 

Font 

 Paragraph 

Structure 

Tables and Borders 

 

25. For entering single and double horizontal lines, you must type the following on the empty 

line: 

 

 --- and press Enter 

- and press Enter 

 === and press Enter 

--- and press CTRL + Enter 

 

26. To set the line spacing, you need to activate the menu item: 

 

Font 

 Paragraph 

Page layout 

 

27. The page orientation (portrait and landscape) is set in the menu item: 

 

Font 

Paragraph 

 Page Layout 

 

28. There are the following main types of text alignment: 
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 left 

at the top 

 on the right side 

 width 

Height 

 centered 

 

29. To cancel or retry a user, there are the following keyboard shortcuts 

 

 CTRL + Z 

CTRL + R 

 CTRL + Y 

 

30. To change the interval between characters, you need to call the menu item: 

 

 tab Font of the same name 

tools group paragraph paragraph tab Home on tape 

 Tools Group Font Tab Home on the Ribbon 

 

Word - creating a table 

 

1. The cell- 

 

intersection of rows and columns 

the minimum unit of the table structure 

container for placing textual information in a table 

 all answers are correct 

 

2. How can I change the width of a column? 

 

 Set the insertion cursor to the desired column, select the LAYOUT tab of the Table 

Properties-Column tab-set the desired width; 

 Move the mouse pointer over the border of the column so that it becomes a two-way 

arrow, click the left mouse button and drag it to the desired location; 

Move the mouse pointer over the border of the column so that it becomes a two-way 

arrow, right-click and drag to the desired location; 

 Call the context menu by right-clicking on the desired column- Table Properties-Column 

Tab-set the desired width. 

 

3. How do I delete a row in a table? 

 

 Call the context menu by right-clicking on the desired line-Delete rows; 

Select the desired line and press Delete; 

 Set the insertion cursor in the desired row, the MAKET tab-Delete table-Delete rows; 

Select the desired line and press Shift + Delete 

 

4. What tab is intended for working with tables? 

 

home 

Page layout 

View 

 Insert 
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5. Which command serves to make the table width the same as the area in which the main text is 

located? 

 

 Context menu-Auto-fit-Auto-fit for width of window 

Context menu-Auto-fit-Auto-fit for column width 

 Tab MAKET-Auto-fit-Auto-fit to the width of the window 

Context menu-Auto-fit-Auto-match by content 

 

6. Which command is used to ensure that the width of the columns best matches the contents of 

the columns? 

 

 Tab MAKET Auto-fit-Auto-match by content 

The MAKET tab Auto-fit-Auto-fit to the width of the window 

Tab MAKET Auto-fit-Fixed column width; 

 

7. How to select the whole table? 

 

Home tab Select- Select objects 

 Left-click once in the upper-left corner of the table 

Home tab Select- Select all 

 

8. How to make the table boundaries invisible? 

 

 Constructor-Borders-no boundaries 

Layout - Borders - no boundaries 

 Home-Frontiers-no boundaries 

Table-Borders-no boundaries 

 

9. How do I delete a selected table? 

 

the Delete key 

Edit-Delete 

Right-click on the table-Delete 

 Layout-Delete-Delete Table 

 

10. How do I add the last row to the table? 

 

 Right-click Insert- Insert rows from the bottom 

 Layout - Insert from the bottom 

Insert-Table-Insert rows from the bottom 

 Move the cursor to the last cell and press Tab 

 

11. List all options for aligning text in cells 

 

only horizontal 

 horizontal and vertical 

only vertical 

or horizontal or vertical 

 

12. What is the dimension of a table and how is it determined? 
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font settings and settings 

the size of the cells 

 the number of rows and columns 

scale 

 

13. List the main ways to build tables 

 

 Insert-Table-Insert Table 

 Insert-Table-Draw Table 

Home-Table-Insert Table 

Table-Insert Table 

 

14. The nested table -... 

 

reticular structure 

 table inserted into another table 

table that stands after another table 

 

15. To create a table name, use the command ... 

 

Insert - Title 

 Insert-Name 

Service-Title Caption 

 

16. To redistribute the column widths, use the following keys: 

 

Shift 

 Shift + Ctrl 

Alt + Shift 

Ctrl 

 

17. To select the entire table, use: 

 

 Set the cursor in the first row of the table, hold until the end of the table Shift + 

Alt + t, d, in 

Constructor- Select - Select table 

 Layout-Select - Select table 

 

18. To add a row / column, use: 

 

Edit-Copy 

 Tab with Tables - Ribbon Layout - Group Rows and columns select Paste from top, bottom / 

left to right 

Home- Copy 

Tab Working with tables - Ribbon constructor - group Rows and columns select Paste from 

top, bottom / left to right 

 

19. To cut a row / column use: 

 

Shift + Delete 

Ctrl + Delete 
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Select the required number of rows / columns to use the tab Work with tables - Ribbon 

constructor - group Rows and columns select the Delete button- delete columns / rows 

 Select the required number of rows / columns to use the tab Working with tables - Ribbon 

layout - group Rows and columns select the Delete button- delete columns / rows 

 

20. To combine cells use: 

 

 context menu, Merge Cell function 

Alt + t, t 

Select the required number of rows / columns to use the Tab Work with Tables - Ribbon 

Designer - Merge Cells 

 Select the desired number of rows / columns to use the tab Work with tables - Ribbon 

layout - Merge cells 

 

21. The combination of Shift + Tab ... 

 

moves the cursor one cell to the right 

 moves the cursor one cell to the left 

moves the cursor one cell down 

moves the cursor one cell up 

 

22. To change the structure of the table and format it is used: 

 

Borders toolbar 

 Tab with Tables - Ribbon Designer 

Working with Tables tab - Ribbon Layout 

 

23. Means to reflect the nesting of information include: 

 

tables 

 nested tables 

 lists 

cells 

 

Basic technologies of Excel 

 

. 1. How do I enter formulas into a table cell? 

 

after the selection of a specific cell 

after setting the cursor in a certain cell 

there is no correct answer 

 after setting the sign = in a certain cell 

 

2. What key combination on the keyboard is used to select the required area of cells: 

 

Tab + 

 Shift + 

Alt 

Ctrl + 

 Shift + 

 Shift + 

 Shift + 
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3. The completion of cells is: 

 

 way of entering information 

variety of formulas 

type of filling 

 how to copy data in a cell 

 

4. The cells of the spreadsheet consist of: 

 

 column name and line number 

line numbers 

line number and column name 

column name 

 

5.How do I hide the column? 

 

Service → Hide → Column 

 Format → Hide or Show → Hide Column 

Data → Hide → Column 

Format → Column → Hide 

 

6.How do I delete cells? 

 

select cells, on the Edit menu, select Delete ... then, select the type of deletion from the 

proposed list and click Ok 

Select cells and press the "Delete" key 

Select cells and press the Backspace key 

 select cells, in the context menu select Delete ... then, select the type of deletion from the 

offered list and press Ok 

 

 

7. Specify the mandatory interface elements of the MS Excel working window. 

 

 editing line 

 table cell 

scale 

 autocomplete point 

object labels 

 status bar 

 

8. In each cell of the spreadsheet, you can enter: 

 

 date and time 

 numeric information 

 hyperlink 

 text information 

there is no correct answer 

 calculation formula 

 

9. To edit the data in the cell, use the function key: 
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F8 

F3 

F5 

 F2 

 

10.How do I group the rows? 

 

 Data → Group 

 SHIFT + ALT + RIGHT ARROW 

Data → Group and Structure → Group 

SHIFT + ALT + ARROW LEFT ARROW 

 

11. List all known methods of copying information in cells of the spreadsheet 

 

 using the context menu 

using the keyboard shortcut Shift + Insert 

 using the button in the "Clipboard" 

with the Alt + Insert key combination 

 using the keyboard shortcut Ctrl + Insert 

 

12.Which symbol starts the formula in Excel? 

 

- 

+ 

$ 

 = 

* 

 

13. The Excel sheet is: 

 

 information entry and editing area, which is a table consisting of rows and columns 

a spreadsheet area for entering information, having its own unique name, consisting of the 

name of the column and the sequence number of the line 

 

14. How can I single out the entire column? 

 

 dragging the mouse 

there is no correct answer 

 highlight column name 

 Shift + 

 

15. To insert a cell, use the following combination of keys: 

 

Ctrl + Insert 

 Ctrl + Shift + = 

Ctrl + Shift 

Tab + Insert 

 

16. How is the cell address determined? 

 

line name 

column number 
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 column name and line number 

column number and line name 

 

17. Give the definition of the absolute cell reference. 

 

 the address of the cell used in the formula, which, when moving, copying does not change 

the address of the cell used in the formula, which, when moved, the copy will change in a 

certain way depending on the insertion point 

 

 

18. To finish editing the data in the cell, click: 

 

F2 

Shift 

 Enter 

Alt + Enter 

Shift + Alt 

 

19. How to merge cells in Excel? 

 

Edit → Merge Cells 

 Format of cells → Alignment → Merge cells 

Edit → Cells ... → Merge cells 

Format → Cells ... → Align → Merge Cells 

 

20. Where is the copy marker of the cells? 

 

 a thick dot in the lower right corner of the cell. The marker is visible only on the selected 

cell 

a thick dot in the bottom left corner of the cell. The marker is always visible on each cell 

A thick dot in the lower right corner of the cell. The marker is always visible on each cell 

 

 

21. The minimum component of the table is: 

 

there is no right answer 

formula 

 cell 

sheet 

book 

 

22. When filling the cells is copied: 

 

the values of the last line 

 the values of the first line and the layout of it 

design of the first line 

values of the first line 

 

23. In what way can I select a range of cells? 

 

using the keyboard combination - Shift + Insert 

 using the keyboard combination - Shift + "up arrow" 
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 using the keyboard combination - Shift + "right arrow" 

 dragging with the mouse 

 using the keyboard combination - Shift + "arrow to the left" 

using the keyboard combination - Ctrl + Insert 

 using the keyboard combination - Shift + "down arrow" 

 

24. The rows in Excel are numbered: 

 

Roman numerals 

are not numbered 

letters of the Latin alphabet 

 Arabic numerals 

 

25. What value can the cell take? 

 

 All listed 

textual 

returned 

numeric 

 

 

 26. The absolute reference differs from the relative presence: 

 

character & before the name of the column and (or) line 

there is no correct answer 

 the $ sign before the name of the column and (or) the row 

() before the name of the column and (or) the line 

 

27. The name for the columns in Excel is given by: 

 

Arabic numerals 

Roman numerals 

there is no correct answer 

 letters of the Latin alphabet 

 

28.What kind of software products does the Excel spreadsheet include? 

 

 application programs 

programming systems 

system programs 

 

29.How do I place text in two lines in one cell? 

 

 by pressing Alt + Enter 

by pressing the keyboard shortcut Ctrl + Enter 

by pressing the keyboard shortcut Shift + Enter 

Press Enter 

 

 30. To combine a group of cells use the command: 

 

 Alignment 

Font 
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Data 

Reviewing 

 

31.What is MS Excel? 

 

 Spreadsheet 

word processor 

graphics editor 

 

 

32.How do you enter and edit the data in the cell? 

 

 in the edit line 

in the status bar 

 directly in the table cell 

when you press F1 

 when you press the F2 key 

 

33. The sheet of the spreadsheet has the following dimensions: 

 

256 columns, 1000 rows 

500 columns, 1000 rows 

256 columns 65536 rows 

 16384 columns, 1048576 rows 

256 columns, 1650 rows 

 

34. How can I single out the entire line? 

 

 dragging the mouse 

there is no correct answer 

 highlight line number 

 

35. Specify the order of the formula entry in the cell 

 

2. Enter "=" (equal to) 

1.Specify the cell 

3. Enter a cell, an arithmetic or boolean expression or function 

 

36. Which of the following is not a characteristic of the cell? 

 

value 

name 

address 

 size 

 

37. There are many types of links for describing the address of a cell: 

 

 3 

1 

2 

4 
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38. To display hidden rows or columns, use the tab: 

 

Insert 

View 

Data 

 Home 

 

39. To set a certain type of data alignment in a cell, use the Format tab of the Cell Format dialog: 

 

View 

Border 

 Number 

Alignment 

 

40. To group rows and columns use the tab: 

 

 Data 

View 

home 

Insert 

 

41.How many sheets does the Excel workbook contain: 

 

 3 

2 

4 

1 

 

42. The Excel document has the extension: 

 

pptx 

 xlsx 

docx 

exe 

 

Lists and databases 

 

1. The list should (choose the correct options): 

 

 To be completely placed on one sheet of excel 

 the first line of the table must contain the names of the fields 

contain exactly 65535 rows and 256 columns 

Each cell in the same column must contain a different type of data and content information 

 

2. A list entry containing certain information is called ... 

 

list title 

 list item 

there is no correct answer 

list line 

list cell 
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3. What should the first line of the list contain? 

 

list header 

empty cells 

 field names 

there is no correct answer 

 

4. Which of the following functions are summarizing functions? 

 

 SUM 

SUMMER 

 ACCOUNT 

 WORKSHOP 

 COUNTAIN 

IF 

ROUNDWOOD 

 AVERAGE 

 DISP 

ACCOUNTS 

 

5. Specify the procedure for obtaining totals in the list: 

 

1.provide sampling of values by arbitrary criteria (include auto filter) 

3. use the INTERMEDIATE.TOTOGI function to summarize 

2. Assign a specific name to the list 

 

6. To obtain the total cumulative statements, you must use the tool ... 

 

 Data - Structure - Subtotals 

Insert -> Data -> Results 

Edit -> Results ... 

Data -> Results ... 

 

7. The first argument of the INTERMEDIATE.SERT function is ... 

 

the name of the list by which to calculate the totals 

reference to a range of cells 

 number from 1 to 11, which determines one of the functions of summing up 

range of cells 

 

  

8. The list item is ... 

 

column in table 

list header 

table cell 

 list entry 

row in the table 

 

9. What are the requirements for the list? 

 

 The first line of the table must contain the names of the fields 



45 
 

there is no correct answer 

 Must be completely placed on one Excel sheet 

 The cells of a single column must contain information that is homogeneous in terms of 

data type and content 

 

10. How do I install the AutoFilter? 

 

Service -> Filter -> AutoFilter 

Data -> Filter -> AutoFilter 

Data -> AutoFilter 

 Data - Sort and Filter - Filter 

Home - Editing - Sorting and filtering - Filter 

 

11. In order to assign a specific name to the list, it is necessary (specify the correct order): 

 

4. Press Ok 

2. Insert -> Name -> Assign or Ctrl + F3 

3. Enter a name for the range without spaces 

1.Select the area of the cells in the list together with the row of field headers 

 

12. How is the function used to summarize the filtered list? 

 

 INTERMEDIATE 

LIST OF INTERMEDIATE 

FILTER.ITOGI 

RESULTS 

 

13. The maximum size of the list ... 

 

256 rows and 256 columns 

 65535 rows and 256 columns 

no restrictions 

256 rows and 65535 columns 

 

14. Sorting is .. 

 

data change 

data filtering 

 ordering records of the table 

editing data 

 presentation of the list data in a certain order 

 

15. Which of the listed functions are NOT functions of summing up? 

 

STDEV 

MIN 

 ACCOUNTS 

DISPPR 

 ROUNDWEIGHT 

SCORE 

 IF 

STDEVKLONP 
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MAX 

 FASHION 

 

16. How to assign names to Excel lists? 

 

Data -> Name -> Assign 

Edit -> Name -> Assign 

-> Name -> Assign 

Insert -> Link -> Title 

 

17. Data filtering is used ... 

 

to simplify the information retrieval process 

there is no correct answer 

to simplify the process of entering and deleting records 

 to display the required information 

to sort data 

 

18. Data entry and editing of lists can be made ... 

 

only using the screen form 

there is no correct answer 

 the same as for normal Excel spreadsheets 

 

19. To complete and edit the data in the list, you must run the command ... 

 

 Home - Editing - Sorting and filtering - Filter 

File -> New 

Data -> Edit ... 

Edit> Fill 

 

20. PivotTable technology ... 

 

The content of the source list 

 does not change the original list 

 

21. Filtering is ... 

 

editing data 

 data sampling process 

ordering table records 

 selection of entries in the lists 

 

22. To sort in the list, you must run the command ... 

 

Office - Create lists for sorting and filling 

Data -> Sorting 

 Office - Excel Options - Basic options for working with Excel - Create lists for sorting and 

filling 

Data -> Insert -> Sorting 

 

23. The syntax of the INTERMEDIATE function is: 
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function number; number1; number2; ... 

interval; criterion 

 function number; reference1; link2; ... 

interval; criterion; sum_intervals; 

 

24. A list or database in Excel is called ... 

 

 rectangular configuration table 

information block 

list 

summary table 

 

25. To obtain the final cumulative statements, you must use the tool ... 

 

Data -> Results ... 

Edit -> Results ... 

 Data - Structure - Subtotals 

Insert -> Data -> Results 

 

 

26. To work in Excel with pivot tables there is a command: 

 

Data - Insert - Tables - Summary table. 

 Insert - Tables - Summary table. 

Insert - Summary table. 

There is no correct answer 

 

Excel functions. 

 

1.Expression, which is used in the calculation of functions, is called 

function syntax 

function formats 

 arguments of the function 

names of functions 

 

 2. The arguments of a function can be 

 links 

 data ranges 

 other functions 

 different expressions 

there is no correct answer 

 

3. Arguments of the Excel function 

are enclosed in square brackets and are indicated by a semicolon 

are enclosed in square brackets and are separated by commas 

are enclosed in parentheses and are separated by commas 

 are enclosed in parentheses and are indicated via a semicolon 

 

4. The syntactic function is called 

Function name and format 

 the sequence in which the arguments of the function 
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function argument list 

expression used to evaluate functions 

 

5. The function form is 

 name of the function and its syntax 

function arguments 

function name and parentheses 

there is no correct answer 

 

6. Functions that are arguments of another function or are part of its expressions are called 

built-in 

 nested 

complex 

logical 

 

7.In Excel you can use 

no more than five levels of nesting functions 

less than seven levels of nesting functions 

 up to seven levels of nesting functions 

ten levels of nesting functions 

any level of nesting functions 

 

8. By type of data being processed, Excel functions can be classified into 

 mathematical functions 

financial functions 

 Boolean functions 

 Text functions 

statistical functions 

 Functions for processing the date and time 

functions for working with databases 

 

9. Which of the listed functions are mathematical? 

 URBAN 

 OCTOBER 

MAX 

 SUM 

 FACT 

IF 

 SUMMARY 

 

10. Which class of functions are trigonometric functions? 

Logical functions 

 Mathematical functions 

Statistical functions 

There is no correct answer 

 

11.Fashion function 

returns the current date 

 determines the most common number 

returns the number module 

converts a date in a textual representation to a numeric type "Date and time" 
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12. Which of the built-in functions converts a number to text? 

H 

SIGNIFICANT 

 T 

NUMBER 

There is no correct answer 

 

13. Which of the built-in functions converts a number into text and formats it? 

H 

NUMBER 

SIGNIFICANT 

 TEXT 

T 

 

14. Which function returns the date in a numeric format based on the parameters year, month, 

number? 

DATAZNACH 

TODAY 

 DATE 

This function does not exist 

 

15. Which of the listed functions are logical? 

 IF 

SUMMER 

ACCOUNTS 

 OR 

SUM 

SCORE 

 NOT 

 

16.Which function can I use instead of the AutoSummit tool? 

 SUMMKV 

 SUM 

SUMPRODUCT 

SUMMER 

This function does not exist 

 

17.To use the Auto Sum tool 

 move the cursor to the cell that will contain the amount; then activate the tool and select a 

certain range with the mouse, then press Enter 

Move the cursor to the cell that will contain the amount; then activate the tool and select a 

specific range with the mouse, then press Alt + Enter 

 

18. To sum the values of the cells you need: 

 select the range of summable cells along with the resulting row / column and press Alt + 

select a range of summable cells along with the resulting row / column and press Alt + 

Enter to select the range of summable cells along with the resulting row / column and 

click on * use the SUM function * use the function SIGNED 

 highlight the range of summable cells along with the resulting row / column and click on 

 use the SUM function 

use the function SIGNIFICANT 
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19. Which Excel function counts the number of non-empty cells that satisfy the specified 

condition? 

IF 

MEMBERS 

 ACCOUNTS 

AVERAGE 

SUM 

 

20. Which Excel function summarizes cell values? 

SIGNIFICANT 

AVERAGE 

 SUM 

SUMMER 

SUMMKV 

 

21. Which Excel function summarizes the values of cells that satisfy the given condition? 

SUM 

AVERAGE 

SIGNIFICANT 

 SUMMARY 

ACCOUNTS 

 

22. Which function determines the minimum value from the list of numbers? 

FASHION 

SIGNIFICANT 

AVERAGE 

DATAZNACH 

 There is no correct answer 

 

23. To perform operations in accordance with the condition, the function 

SUMMER 

ACCOUNTS 

 IF 

OR 

NOT 

 

24. Which of the following functions are used for rounding operations? 

 ROUNDWEIGHT 

UBR 

 OCTOBER 

 ROUNDBACK 

MOPRED 

 DISTRICT 

 

25. To use the built-in Excel function, you need to do the following: 

3 

Select the desired built-in function in the Function Wizard dialog and click OK 

1 

Enter the initial information presented in the variant of the assignment 

2 

Activate Function Wizard 
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26. How can I call the function wizard in Excel? 

 

 in the editing line with the button "Insert function" 

 the FORMULA tab by pressing the "Insert function" 

the DATA tab with the "Insert function" button 

 Home tab 

 

27.What is the range searcher? 

The Excel tool is designed to search for cells and ranges of cells that contain built-in 

functions. 

 Excel tool for visual selection of cells and cell ranges 

 

28.How to allocate a range of cells? 

Ctrl + Arrows 

 Shift + arrows 

 Use the mouse (with the left button pressed) 

With the mouse (with the right button pressed) 

 

29. What arguments does the IF function have? 

 Boolean expression 

criterion 

interval 

 true value 

 value is false 

 

30. What arguments does the function of ACCOUNT have? 

logical expression 

 criterion 

value is true 

 italval 

 

31. The MAKS function as arguments can have: 

 specific numbers 

criterion 

 cell area 

 range names 

logical expressions 

 

32. What function determines the length of a string? 

EPR 

 DLRES 

STRUCTURE 

SIGNIFICANT 

There is no correct answer 

 

Charts and diagrams 

 

1. There are the following types of pie charts: 

Secondary cut circular 

 Secondary circular 

Secondary circular histogram 

 Circular 
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 Volumetric cut circular 

 Volumetric circular 

 

2.Circle diagrams 

 are used to display a relative value that is integral 

are designed to demonstrate discrete data 

are used to represent continuous data 

there is no right answer 

are used to display the results of comparing one indicator under different conditions 

 

3.Column diagrams 

 are used to display the results of comparing one indicator under different conditions 

used to display the dependence of a function on an argument 

are used to represent continuous data 

are used to display a relative value that is integral 

 designed to demonstrate discrete data 

 

4. What are the main aspects of formatting listed in the menu item Chart 

change chart name 

changing the size of the chart 

 changing the placement of the chart 

 changing the source data 

  changing the parameters of the chart 

 Changing the chart type 

 

5. An embedded diagram is ... 

 A graphic object that is saved as part of the sheet on which it was created 

there is no right answer 

A separate sheet in the book that has its own name 

diagram inserted in another 

 

6.Diagrams and graphics ... 

help to make complex calculations and visualize calculated data 

 simplify the process of comparing disparate data 

 help to identify patterns and trends in data 

 facilitate the perception of information 

 

7. The legend is ... 

chart area 

data pin 

 text decoding of graphically presented data 

 area of data series signatures 

 

8. Specify the required elements for the design of any chart and chart: 

there is no right answer 

headers, data series, grid lines 

data table, axes, legend 

 titles, legend, data signatures 

 

9.Diagram ... 

 is associated with the data it is based on and is updated automatically when the data is 

changed 
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both statements are incorrect 

is associated with the data on which it was created, but is not updated automatically when 

the data is changed 

 

10.How to change the format of the data point? 

Double-click on the data point, in the window that appears, make all necessary changes 

and click Finish. 

 For a data point, call the context menu ---> Format data point, then make all necessary 

settings ---> Finish 

Select the menu item Diagram ---> Chart Properties, then make all necessary settings ---> 

Finish 

 

11.Connection of values in the diagram: 

 Share 

 Text categories 

Chart Title 

 Numeric values 

 

12. Specify the correct sequence of actions when plotting the diagram. 

3 

call the Chart Wizard 

5 

click finish 

4 

carefully reading all the bookmarks of the dialog window of the chart wizard at each step, 

choose further 

2 

select a range of data in the table 

1 

enter data 

 

13.To create a diagram you need ... 

 use the Toolbar Diagram 

select the entered data, use the button to insert functions, and then call the Chart Wizard 

select the entered data, call the Function Wizard, and then use the Chart Wizard 

 highlight the entered data and use the Chart Wizard 

 

14.Diagram can be created ... 

only on a separate sheet 

 on a separate sheet or placed as an embedded object on a sheet of data 

there is no right answer 

only by placing it as an embedded object 

 

15. After building the chart, you can 

 resize it 

 copy it 

 change the source data 

insert it into another diagram 

 Change the font, color, position of any chart element 

 delete it 

 change its position on the sheet 

 change its type and parameters 
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16. Graphs and diagrams must be built ... 

for the development of human creativity 

there is no correct statement 

 for solving communicative problems 

 

17. For what it is necessary to build charts and diagrams 

for the development of human creativity 

to visualize the data presented in tabular form 

 to facilitate the perception of information, simplifying the process of comparing the 

presented data 

 

18. The graph is intended for: 

showing the relative value of a unit 

demonstrating discrete data 

 display of the function's dependence on the argument 

There is no correct answer 

 

19.Select the correct order for creating the chart: 

 Select the required data range 

 

Modeling of physiological, morphological, molecular-genetic and biochemical processes 

 

1. List the main advantages of using databases in comparison with the traditional paper 

method of information storage. 

 Compactness 

 Speed 

 Efficiency 

Low power consumption 

Consistency 

 

2. List the features of relational databases 

 Elements are tables consisting of fields (columns) and rows. 

It consists of a set of nodes, located at different levels, connected to each other 

Can be represented in the form of objects located at different levels 

 Contains a list of objects of the same type 

 

3. Which form form corresponds to the following description: when creating a form of this type, 

the fields of the current record will be displayed one after the other from top to bottom, for each 

field a separate "Inscription" object will be created? 

Tape form 

 In one column 

Tabular 

Aligned 

Summary table 

 

4. Specify the existing categories of database users. 

 Application programmers 

 End users 

Domain Specialists 

 Database administrators 

The experts 
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5. Specify the existing database types. 

 Network 

 Hierarchical 

Tabulated 

Linear 

 Relational 

Computer 

 

7.What is the database user interface? 

Special hardware that provides user interaction with the database 

 A set of input, output and user interaction tools with the database 

A set of dialog boxes providing output of messages about errors that occur when the user is 

working with the database. 

 

8.What is an information system? 

 A set of organizational, technical, software and information tools designed to collect, store, 

process and issue the necessary information. 

A computer program based on a database that allows you to accumulate large amounts of 

data 

The totality of information about any processes 

 

9. Specify the main element used to organize the database dialog with the user. 

Stored procedure 

Macro 

 Window 

Inquiry 

Diagram 

 

10. List the database objects. 

Files 

Access rights 

Members List 

 Tables 

 Requests 

 Forms 

 

11. What type of databases is most common now? 

Object-oriented 

Hierarchical 

 Relational 

Network 

 

12. Specify the rules that you need to consider when choosing the form view. 

With a small number of fields in the source table, a summary table is created. 

 With a large number of table fields, an aligned form or "one column" shape is created. 

For small forms, a combination of two forms is created: one in the form of a list, the other 

in the form of a "one column" form. 

 

13.What is the Database? 

data on all possible states of the object in the subject domain 

list of files on disk 
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 named set of data, reflecting the state of objects and their relations in a particular subject 

area. 

data on the relationship to each other and the mutual influence of objects 

clutter 

 

14. Why is it necessary to translate information into an electronic form? 

because paper documents are unreliable 

because it is modern and relevant. 

because you need to use computers. 

 because in this case the possibility of its repeated use and automated processing is 

facilitated 

 

15. Specify possible variants of appearance of the form created in Access 

 Belt 

Custom 

 Aligned 

 Tabular 

Arbitrary 

Random 

 

16. List the main functions of the database management system. 

 Information integrity control. 

 Control of access to data by users. 

Ensuring the interaction of the computer with peripheral equipment. 

Execution of a program that accesses data. 

 Write data to physical media, and read this data. 

17.The subject area is ... 

Geographic area that is exposed to any objects. 

Science, which studies the influence of objects and phenomena on each other. 

 Part of the real world to be studied. 

Area (place) of the action of an object. 

 

18. Specify possible ways of creating forms in Access 

Using modules and macros 

 Using the wizard 

 Using the constructor 

Using the program code 

 

19.What is the data source for the form? 

 The data set used to display on the form. 

The contents of one of the database tables 

Form Header 

Data about the user who created the form and its security rights. 

 

20. Why should I use databases? 

 they allow to increase the efficiency of obtaining information. 

they can reduce the energy consumption of computers. 

they allow to increase the speed of information input. 

 they allow you to reuse stored information. 

 

21. List the features of network databases 

Can be represented in the form of objects located at different levels 
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 Consists of nodes with identifiers 

 Contains both horizontal and vertical links between objects. 

Elements are tables consisting of fields (columns) and rows. 

 

22. Relationships between objects in the domain are ... 

The data types used to describe the columns of a table 

 Communication between database tables 

Fields of database forms 

Diagram of database tables 

 

23. Which control is used to organize the selection of one option from several possible when 

creating a form in design mode? 

Switch group 

Inscription 

Switch 

 Combo box 

 

24.Provide ways to move the elements of the form. 

 Using the properties window of the control 

 Using the mouse 

Using the vertical and horizontal scroll bars 

Using the toolbar 

 

25. List the capabilities of end users when interacting with the database 

 Performing tasks for processing data stored in the database 

 Accessing the database 

Application Development 

 

26. List the sections that exist on the form in Design view 

 Form heading 

Running title 

Status string 

 Data area 

 

27. List the features of hierarchical databases 

 Can be represented as objects located at different levels 

 Consists of nodes with identifiers 

Contains a list of objects of the same type 

 

28.What is a database management system? 

 A class of programs that allows you to create and work with databases. 

Special software that monitors user access to data stored in the database regardless of the 

hardware features. 

A computer program that allows the user to simultaneously use several different databases, 

perceiving them as a single whole. 

 

29. What is included in the list of duties of the database administrator? 

Application Development 

 Creating a database 

 Maintenance and support of the database in working order. 

Performing tasks for processing data stored in the database 
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30. What is a database? 

Any text file 

 Organized structure for storing information 

Any information presented in tabular form 

Any spreadsheet 

 

31. Which of the following properties is not a property of the relational database? 

 Multiple level nodes are connected to a node of the same level 

The order of the rows in the table is arbitrary 

Each column has a unique name 

For each table, you can define the primary key 

 

32.What is SQL? 

Database markup language 

 Structured Query Language 

Low-level programming language 

High-level programming language 

 

33. Which database is based on tables and only tables? 

Network 

Hierarchical 

 Relational 

Dynamic 

 

34. Which of the following is not an MS Access object? 

Table 

 Book 

Inquiry 

Macro 

 

35. In which database model do horizontal and vertical links exist between the elements? 

 Network 

Hierarchical 

Relational 

Object-oriented 

 

36. Which of the following can not be built? 

Plain 

Cross 

To create a table 

 Parallel 

Entries without subordinates 

 

37. What is this field? 

 Column in the table 

Designer window 

Text of any size 

The row in the table 

 

38.What is a request? 

Designer window 

Related table 
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Main table 

 Data Selection Tool 

 

39. What is the function of the key field? 

Definitely define a table 

 Define a record unambiguously 

Define the column heading of a table 

Enter a restriction to verify the correctness of data entry 

 

 

40. And what is a macro? 

From the tag set 

From the collection of Visual Basic operators 

From the collection of Visual Basic operators 

 From a set of macros 

 

41. Which section does not exist in the form designer? 

Header 

Header 

Data Area 

Note 

 Final 

 

42. Records are: 

 

Headings 

Columns 

 Rows 

Tables 

 

43. Logical data is: 

 

monetary data 

text 

 one of two values 

number of 

 

44. The automatic extension property has a field: 

 

numeric 

 counter 

memo 

logical 

 

45. Relational databases have: 

 

statistical data 

fields of the same properties 

necessarily embedded objects 

 related tables 

 

46. The key field should be: 
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by all means a counter 

necessarily numeric 

 unique 

should not contain long records 

 

47. The tables serve for: 

 

 storage of information 

settlement 

retrieval of information 

printing tables 

 

48. Methods of creating tables: 

 Design mode 

 using the wizard 

 by entering data 

in MS Excel 

49. The "Designer" button opens: 

 

 object structure 

table contents 

toolbar 

and prints a table 

 

50. Links between tables are needed for: 

 

 creating reports, queries 

to copy data 

 ensuring data integrity 

Automation tasks for making changes 

 

51. Open button: 

 

 opens a table or other object 

allows you to change the table structure 

allows you to record 

allows you to edit records 

 

52. To establish relationships between tables, use: 

 

communication menu 

 Data schema button 

button Properties 

Service  

 Data Diagram 

 

53. The wizard: 

 

extended text 

 set in the Designer mode 

 to automate data entry using a list 
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link setup field 

 

54. Queries are created to retrieve data: 

 

 from several tables 

from only one table 

from other requests 

from several tables and queries 

 

55. Ways of creating queries: 

 

 with the help of the Wizard 

 Constructor 

Simple query 

Cross-Request 

 

56. As a result of queries, the following are created: 

 

request forms 

relational tables 

 result tables 

reports 

 

57. Reports are created for: 

 

data entry 

 Printout of the required information 

output to the screen of the necessary information 

retrieval of information 

 

58. Reports are created on the basis of: 

 

 basic tables 

 requests 

other reports 

 

59. The database is: 

 

 is an integrated set of structured and interrelated data, organized according to certain 

rules; 

This is part of the real world to be studied in order to create a database to automate the 

management process; 

This is a collection of software and hardware, methods and people that provide collection, 

storage, processing and delivery of information to solve assigned tasks 

 

60. The subject area is: 

 

It is an integrated set of structured and interrelated data organized according to certain rules; 

 This is part of the real world, to be studied in order to create a database to automate the 

management process; 

This is a collection of software and hardware, methods and people that provide collection, 

storage, processing and delivery of information to solve assigned tasks 
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61. Indicate the main data models: 

 

 relational 

registration 

 hierarchical 

 network 

 

62. The one-to-many relationship is: 

 

The ratio at which each record from one table corresponds to one entry in another table 

 The ratio at which each record from one table corresponds to several records of another 

table 

 The ratio at which one, a set of records from one table corresponds to one entry in 

another table 

The relation at which to set of records from one table corresponds several records in other table 

 

63. Many-to-many attitude is: 

 

The ratio at which each record from one table corresponds to one entry in another table 

The ratio at which each record from one table corresponds to several records of another table 

The relation at which to one, to set of records from one table corresponds one record in other 

table 

 The ratio at which multiple entries from one table correspond to multiple records in 

another table 

 

64. A one-to-many relationship is created when: 

 

 only one of the fields is a primary key field or a unique index. 

When both linked fields are key or have unique indexes 

 

65. The primary key is: 

 

 hese are one or more fields (columns) whose combination of values uniquely identifies 

each entry in the table. 

one or more fields (columns) in the table that contain a reference to the field or fields of the 

primary key in another table 

 

66. Types of keys: 

 

 primary 

universal 

atomic 

 external 

 

67. A simple key ... 

 

 Consists of one field 

Consists of several fields 

Consists of one record 

Consists of several entries 
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68. The compound key ... 

 

Consists of one field 

 Consists of several fields 

Consists of one record 

Consists of several entries 

 

69. The essence is 

 

 any concrete or abstract object in the subject domain; 

this property of the object in the domain; 

the relationship between objects in the domain 

 

70. The attribute is: 

 

the relationship between entities in the domain. 

 this property is an entity in the domain. 

any particular or abstract object in the subject domain 

 

71. Stages of DB design: 

 

 Study of the subject area; 

Selection of software to create a database; 

 Data analysis (entities and their attributes); 

Presentation of data in the form of tables; 

 Definition of relations between entities and definition of primary and secondary 

(external) keys. 

 

72. The main features of the Microsoft Access database include the following: 

 

 Design of basic objects - two-dimensional tables with fields of different data types. 

 Creating links between tables, supporting data integrity, cascading field updates, and 

cascading delete entries. 

 Creating links between tables, supporting data integrity, cascading field updates, and 

cascading delete entries. Creation, modification and use of derived objects (queries, forms 

and reports). 

Create and add graphic files; 

 

73. The main window of the Microsoft Access application consists of the following areas 

 

 title bar; 

 menu bar; 

working space 

 the toolbar; 

 Database window; 

structural elements of the tables. 

 status bar. 

Control Panel 
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Module 

1. List the main database models 

 

 relational 

 network 

rational 

system 

 hierarchical 

architectural 

 

2. For a one-to-many relationship ... 

 

Each record from one table corresponds to one entry in another table; 

 Each record from one table corresponds to several records of another table 

Multiple entries from one table correspond to one entry in another table; 

Multiple entries from one table correspond to multiple records in another table 

 

3. With respect to the many-to-many relationship ... 

 

Each record from one table corresponds to one entry in another table; 

Each record from one table corresponds to several records of another table; 

one, the set of records from one table corresponds to one entry in another table 

 multiple entries from one table correspond to multiple records in another table 

 

4. The primary key is ... 

 

 these are one or more fields (columns) whose combination of values uniquely identifies 

each entry in the table. 

this is one or more fields (columns) in the table that contain a reference to the field or 

fields of the primary key in another table. 

this is a column (there may be several columns) added to the table and allows you to link to 

records in another table. 

 

5. External (secondary) key 

 

this is a column (there may be several columns) added to the table and allows you to link to 

records in another table. 

this is one or more fields (columns), the combination of which uniquely identifies each 

entry in the table. 

 it is one or more fields (columns) in the table that contain a reference to the field or fields 

of the primary key in another table. 

 

6. The essence is ... 

 

 any particular or abstract object in the subject domain 

this property of the entity in the domain. 

the relationship between entities in the domain. 

 

7. Attribute is ... 

 

any concrete or abstract object in the subject domain. 

 this property is an entity in the domain. 
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the relationship between entities in the domain. 

 

8. Communication is ... 

 

 the relationship between entities in the subject area. 

this property of the entity in the domain. 

the relationship between entities in the domain. 

 

9. In MS Access, you can create: 

 

tables 

 requests 

 Reports 

 pages 

 Macros 

 module 

 

10. List the database objects. 

 

Files 

Access rights 

Members List 

 Tables 

 Requests 

 Forms 

 

11. What type of databases is most common now? 

 

Object-oriented 

 Relational 

Hierarchical 

Network 

 

12. What is a Database? 

 

data on all possible states of the object in the subject domain. 

list of files on disk 

 named set of data, reflecting the state of objects and their relations in a particular subject 

area. 

data on the relationship to each other and the mutual influence of objects 

clutter 

 

13. List the main functions of the database management system. 

 

 Information integrity control. 

 Control of access to data by users. 

Ensuring the interaction of the computer with peripheral equipment. 

Execution of a program that accesses data. 

 Write data to physical media, and read this data. 

 

14. The subject area is ... 
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Geographic area that is exposed to any objects. 

Science, which studies the influence of objects and phenomena on each other. 

 Part of the real world to be studied. 

Area (place) of the action of an object. 

 

15. What are the possible ways to create forms in Access? 

 

Using modules and macros 

 Using the wizard 

Using the program code 

 Using the constructor 

 

16. What is a database management system? 

 

 A class of programs that allows you to create and work with databases. 

Special software that monitors user access to data stored in the database regardless of the 

hardware features. 

A computer program that allows the user to simultaneously use several different databases, 

perceiving them as a single whole. 

 

17. The request is ... 

 

A tool that allows you to simplify the process of entering or modifying data in the database 

tables, which ensures data entry by the staff of low qualification 

 means for selecting data that meet certain conditions. With the help of queries, you can 

select only the necessary information from the database 

a tool that allows you to extract the necessary information from the database and present it in a 

form that is easy to read, and also prepare a report for the printout, which is designed 

accordingly. 

two-dimensional tables that are used to store data in relational databases. 

 

18. The report is ... 

 

means for selecting data that meet certain conditions. With the help of queries, you can select 

only the necessary information from the database 

A tool that allows you to simplify the process of entering or modifying data in the database 

tables, which ensures data entry by the staff of low qualification 

 a tool that allows you to extract the necessary information from the database and present 

it in a form that is convenient for perception, and also prepare a report for the printout 

that is properly designed. 

two-dimensional tables that are used to store data in relational databases. 

 

19. List the basic modes of creating a table 

 

 Design mode 

import tables 

 Using the wizard 

using a template 

 by entering data 

 

20. The composition (structure) of the table is determined in the field of the draft table, which 

consists of three columns 
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 Name of the field; 

 Data type; 

 Description. 

Additionally 

 

21. The data type of the counter is ... 

 

text or combination of text and numbers 

 automatic insertion of unique sequential or random numbers when adding a record 

data that accepts only one of two possible values 

alphanumeric data 

 

 

22. The following shall be considered records: 

 

Headings 

Columns 

 Rows 

Tables 

 

23. Fields are: 

 

Tables 

Headings 

 Columns 

Rows 

 

24. The auto-build feature has a field: 

 

numeric 

logical 

 counter 

Memo 

 

25. Relational databases have: 

 

statistical data 

fields of the same properties 

necessarily embedded objects 

 related tables 

 

26. The key field should be: 

 

by all means a counter 

necessarily numeric 

 unique 

should not contain long records 

 

27. Tables serve for: 

 

 storage of information 
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settlement 

retrieval of information 

printing tables 

 

28. The "Designer" button opens: 

 

 object structure 

table contents 

toolbar 

prints a table 

 

29. Types of keys: 

 

 Primary 

Universal 

Atomic 

 external 

 

30. A simple key ... 

 

Consists of several fields 

Consists of one record 

Consists of several entries 

 Consists of one field 

 

31. The composite key ... 

 

Consists of one field 

 Consists of several fields 

Consists of one record 

Consists of several entries 

 

32. Open button: 

 

 opens a table or other object 

allows you to change the table structure 

allows you to record 

allows you to edit records 

 

33. The wizard: 

 

extended text 

 set in the Designer mode 

 to automate data entry using a list 

link setup field 

 

34. Queries are created to retrieve data: 

 

 from several tables 

from only one table 

from other requests 

from several tables and queries 
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35. Ways of creating queries: 

 

  with the help of the Wizard 

 Constructor 

Simple query 

Cross-Request 

 

36. As a result of queries, the following are created: 

 

request forms 

relational tables 

 result tables 

reports 

 

37. Reports are created for: 

 

data entry 

 Printout of the required information 

output on the screen of the necessary information of information sampling 

 

38. Reports are created on the basis of: 

 

 basic tables 

 requests 

other reports 

forms 

 

39. The database is: 

 

 an integrated set of structured and interrelated data, organized according to certain rules; 

part of the real world to be studied in order to create a database to automate the 

management process; 

a set of software and hardware, methods and people that provide collection, storage, 

processing and delivery of information for the solution of tasks 

 

40. The subject area is: 

 

It is an integrated set of structured and interrelated data organized according to certain 

rules 

 This is part of the real world, to be studied in order to create a database to automate the 

management process 

This is a collection of software and hardware, methods and people that provide collection, 

storage, processing and delivery of information to solve assigned tasks 
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Information systems of treatment-and-prophylactic establishments. 

 

1. The subject of studying medical informatics is: 

information processes associated with medical and biological problems; 

information processes associated with clinical problems; 

information processes associated with preventive problems; 

 all the above listed processes. 

 

2. The main purpose of the medical IS is: 

 informational support of the tasks of rendering medical assistance to the population; 

management of health facilities; 

 management of medical institutions of health facilities and information support of the 

health care system. 

 

3. Information processing in medical information system can be carried out: 

manually 

mechanized way 

 by manual and mechanized methods 

 automated and automatic ways 

 

4. Medical information systems of the level of health facilities are represented by the main 

groups: 

IC consultative centers; 

medical information banks; 

screening systems; 

FPI IP; 

information systems of research institutes and medical schools. 

 by all listed groups. 

 

5. The main modules inherent in most IIAs are ... 

5 

7th 

10 

 15 

 

6.What does the "statistics" module include? 

 the ability to create reports of any complexity 

export of EMC to external format 

accounting of medical services and mutual settlements with various counterparties of 

medical institutions 

personalized expense accounting in the provision of medical services 

 

7.MiS provides an opportunity to exchange electronic medical cards between different 

institutions, synchronization of financial information reference books. 

electronic medical chart 

 Replication 

interface module 

bed fund 

 

8. MIS should provide the following functions: 

Registration and admission schedule 

Accounting services provided 
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Electronic medical history / electronic medical record 

Settlements with patients, insurance companies and contractors 

Medico-economic standards 

Statistics and analytics 

Hospital Automation 

Branch network management 

Maintenance of DB of patients, medical and nursing staff 

 all the above 

 

9. Work in the IIA is conducted in 

multi-user mode with no access rights 

 multi-user mode with access rights 

 multitasking with access rights 

multitasking mode with no access rights 

 

10.In the system "STATIONARY" there is a possibility of rapid start of ____ modes and 

functions 

2 

4 

 8 

6th 

 

11.For registration in the AIS "Hospital" you need to enter ... 

 employee code 

 password 

server name 

Server IP address 

 

12.Counting of cases of hospitalization is carried out through the menu item ... 

"List" 

 "Patient" 

"History" 

"Hospital sheets" 

 

13. Information from the OBD hospitalization cases is selected from the mode of operation 

Look inside 

Editing 

export 

statistics 

 All of the above 

 

14. Selecting information is done by forming an appropriate filter. The conditions in the filter are 

connected by logical ... 

or 

 and 

not 

if and only if 

 

15When a patient is deleted from the list, the 

 information regarding the patient being removed from all the tables that make up the BDT. 

information regarding the patient being removed from the given table 
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Information support of the medical-diagnostic process. 

 

1.System of diagnostic service is designed for 

 automation of the work of employees of diagnostic rooms 

 simplifying the formation of conclusions 

 image archiving 

 instant access to research archives 

archiving spreadsheets 

 

2. In the subsystem of diagnostic services KIIS (Integrated Medical Information System) the 

following basic documents are provided 

 Functional diagnostics 

 Neurofunctional diagnostics 

Sound Diagnostics 

 Ultrasound diagnosis 

Neural Diagnostics 

 Endoscopic diagnostics 

Endometrial diagnosis 

 

3. To exclude modification of responses after their approval, the capabilities of the security 

subsystem are used 

 EDS 

signature 

 restriction of access 

restricted list of persons 

 

4. The main information is stored in the 

reports 

 formalized forms 

summary tables 

in all listed 

 

5.In special databases, research results can be stored in various formats: 

 exe, bat 

 JPEG, GIF, TIFF, BMP 

 AVI, MPEG, ASF 

 WAV, MP3 

xls, xlsx 

 

6. At this switching of the user from the main database to the selected archive database on 

another server is carried out with the help of 

bookmarks 

 hyperlinks 

lists 

tables 

 

7. What magazines form KIIS? 

 Journal of Functional Diagnostics 

 Journal of the Department of Radiation Diagnostics 

 Journal of Endoscopic Diagnosis 

endocrine diagnostic journal 

journal of the treatment department 
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8. In order to further expand the capabilities of KIIS in the automation of diagnostic units, the 

system has additional solutions: 

 RIS 

CIS 

 LIS 

PIS 

NIS 

9. Radiological information system KIIS »(RIS) is 

 a special set of software within KIIS, which allows to effectively automate the work of 

the radiation diagnostic units of the health facility in the framework of the introduction of 

the patient's unified electronic medical record (EMC). 

a special set of software inside KIIS that allows to effectively automate the work of the 

functional diagnostic units of the health facilities in the framework of the introduction of the 

patient's unified electronic medical record (EMC). 

a special set of software inside KIIS that allows to effectively automate the work of the 

endocrine diagnostic units of the health facilities within the framework of the introduction of the 

patient's unified electronic medical card (EMC). 

a special set of software inside KIIS that allows to effectively automate the work of the 

neurofunctional diagnostics departments of the health facilities within the framework of the 

introduction of a single electronic medical card (EMC) of the patient. 

 

10. Diagnostic examination protocols are created directly 

in a single sheet 

 in the EMC 

in EDS 

in electron fluoride 

 

11. The functional laboratory is connected with 

 by the registry 

 treating doctors 

 treatment room 

an examination room 

 

12. The work of users with a laboratory subsystem is carried out according to the following 

algorithm: 

1 

Choose an outpatient card or a patient's medical history. 

2 

You are given a command to create a new destination. 

3 

Select the desired form 

 

13.The system displays on the screen an empty form for ordering a laboratory test (for example, 

a form of a clinical blood test). In it, the user can perform the following operations: 

 Select the required parameters 

 Correct the date of the study 

 If necessary, choose a laboratory or treatment room 

Correct discharge date 

 

14.Where is the management of reference values, the verification of results and their automatic 

sending to KIIS? 
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 in the module Entering research results 

in the Order List module 

in the module Radiation load sheet 

Purpose of the study 

 

15. The composition of the laboratory information system includes a convenient configuration 

module, consisting of 

 5 tabs 

4 tabs 

6 tabs 

3 tabs 

 

Medical and technological systems of control and management of body functions. 

 

1. The automated workstation (AWP) of the doctor is intended 

for conducting case histories 

storage of case histories 

reporting 

 all the above 

 

2. The functions of the physician's AWS are divided into categories: 

basic and inalienable 

auxiliary 

integral and auxiliary 

basic and auxiliary 

 

3. The basis of ARM is ... 

patient card 

 Electronic medical history 

electronic medical chart 

medical patient insurance policy 

 

4. To enter personal data into the APM program, you must use the command 

 Tools- Settings 

Service-Input Data 

Service-History of the disease 

Service - Medkarta 

 

5.Which tab of the "Program Settings" window contains data about doctors and nurses 

 tab "Cabinet" 

tab "Doctors" 

the "Branches" tab 

Directions tab 

 

6. Which tab contains data for template filling in forms. 

tab "Medical institution" 

tab "Doctors" 

the "Branches" tab 

 Directions tab 

 

7. The main application window - 

electronic medical chart 
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 outpatient magazine 

disease history 

magazine of dispensary patients 

 

8. Which team is used to view the number of patients admitted for a certain interval? 

File - Clinical examination 

File-Report Forms 

 File-Results of work 

File- Patient Search 

 

Automated medical and technological systems of clinical and laboratory research 

and functional diagnostics. 

 

1.MIS is 

 

 a combination of software and hardware, databases and knowledge designed to automate 

the various processes taking place in the health facility and the health care system. 

a combination of software and hardware to automate the various processes that occur in the 

health facility and the health care system. 

a set of software and data bases and knowledge intended for automation of various 

processes taking place in health facilities and the healthcare system. 

a combination of software and hardware, databases and knowledge, designed to automate 

various processes. 

 

2. Database of AIS resuscitation and intensive care is created on the basis of 

MS Excel tables 

MS Word 

 MS Access 

MS WordPad 

 

3. Intensive care cards and their templates are based on ... 

 MS Excel tables 

MS Word 

MS Access 

MS WordPad 

 

4. To start work with AIS "ORIT" run the file 

 RDB_v2.0.mdb 

RDB_v2.0.xls 

RDB_v2.0.dbf 

RDB_v2.0.exe 

 

5. The format of the database settings consists of 

 list of hospital departments 

list of departments of polyclinics 

 list of complications 

 list of causes of death 

list of reasons for hospitalization 

Task Manager 

 linked table manager 

 

6.Change the list of patients you can 
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  changing the filtering parameters in the line "the main function buttons" 

 by changing the filtering parameters in the "search string" 

selecting the "reports and forms" tab 

by pressing the F2 key 

 

7.Master adding new patient opens 

 clicking the "New patient" button in the main form 

by pressing the F2 key 

 by pressing the F4 key 

by pressing F7 

 

8. In what form can you edit (change) mistakenly entered data? 

in the main form 

in the form of a statement 

 in the form of patient details 

in the form of database settings 

9. Under the cards, the IT system understands 

Access database based on the IT map template. 

 an Excel spreadsheet created by a database based on an IT map template. 

 

10. When working with IT cards use the buttons in the upper right corner of the map: 

 New day 

 Assign 

  Cancel 

 Print 

 Boley 

 Undo. bolus 

Remove 

 

Information systems in health management of territorial and federal levels 

 

1. The automated workstation (AWP) of the doctor is intended 

for conducting case histories 

storage of case histories 

reporting 

 all the above 

 

2. The functions of the physician's AWS are divided into categories: 

 basic and inalienable 

 auxiliary 

 integral and auxiliary 

basic and auxiliary 

 

3. The basis of ARM is ... 

patient card 

 Electronic medical history 

electronic medical chart 

medical patient insurance policy 

 

4. To enter personal data into the APM program, you must use the command 

 Tools- Settings 

Service-Input Data 
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Service-History of the disease 

Service - Medkarta 

 

5.Which tab of the "Program Settings" window contains data about doctors and nurses 

 tab "Cabinet" 

tab "Doctors" 

the "Branches" tab 

Directions tab 

 

6. Which tab contains data for template filling in forms. 

tab "Medical institution" 

tab "Doctors" 

the "Branches" tab 

 Directions tab 

 

7. The main application window - 

electronic medical chart 

 outpatient magazine 

disease history 

magazine of dispensary patients 

 

8. Which team is used to view the number of patients admitted for a certain interval? 

File - Clinical examination 

File-Report Forms 

 File-Results of work 

File- Patient Search 

 


